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Getting Started with VFrame Data Center

VFrame Data Center is a solution that helps you optimize resource usage in the data center by creating 
a virtualized view of the resources and rapidly provisioning application infrastructure. You use VFrame 
to create a network definition based on the logical requirements of the application that you want to run 
and to dynamically assign and configure physical resources to the defined network in a coordinated 
workflow.

This chapter helps you understand the product and the basics of using it, and includes the following 
sections:

• Overview of VFrame Data Center, page 1-1

• Understanding How to Use VFrame, page 1-4

• Starting VFrame, page 1-8

• Working with the VFrame Interface, page 1-9

• Viewing Job Logs, page 1-12

• Exiting VFrame, page 1-16

Overview of VFrame Data Center
This section provides an overview of VFrame Data Center, and includes the following topics:

• VFrame and Service-Oriented Data Center Provisioning, page 1-1

• VFrame Features, page 1-3

VFrame and Service-Oriented Data Center Provisioning
Cisco VFrame Data Center is an appliance-based network orchestration solution. Data center 
administrators using VFrame are able to define their application infrastructure as a logical service and 
have it powered by the physical devices in the data center. By providing this layer of abstraction, VFrame 
introduces a service-oriented provisioning model to the data center where physical resources need not 
be tied down to a particular application service. The infrastructure associated with an application service 
is defined in the form of a logical topology called a service template. This provides the catalog of all 
logical devices that need to be used for a particular application with their properties and the network 
relationships that they have to each other. The service template is a programmatic architecture of the 
application infrastructure.
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Overview of VFrame Data Center
By defining application requirements based on service requirements, you can treat the data center as 
pools of resource types and freely share resources among applications based on usage patterns and 
availability requirements. For example, at peak usage time, your database application might need ten 
servers, but after work hours, that requirement might drop to one server. Using traditional provisioning 
models, you would have to dedicate ten servers to the application; using the service model, you could 
provision ten servers during peak hours, but during off-hours you could provision one server, and 
reprovision the other nine servers to another application, such as network backup.

Physical resources are acquired only when you deploy a service network and are released when you 
undeploy it. VFrame monitors the service and remaps, reconfigures, reacquires, or otherwise alters the 
resources as required by the service operations.

In general, service-oriented data center provisioning can provide these benefits:

• Utility resource pooling, reducing the time to add devices—By pooling resources, you can more 
easily share resources among applications. In addition, when you add resources, you add them to the 
pool instead of configuring each new resource to work for a specific application. By sharing 
resources, you can potentially use fewer resources than you would if each application had dedicated 
resources.

• Dynamic repurposing of the service network—When a service is not needed, you can undeploy it 
and deploy other services so that the same equipment is used for more than one service.

• Automated service level management—By defining templates and resource pools, you can specify 
the type of equipment required by the service, including processor speed, amount of memory, and 
other performance-related parameters. Thus, you can define the level of service required, providing 
high-performance or even low-performance services, as required by your service-level agreements.

• Automated failover—Resource pooling makes it possible to automate failover. If a device stops 
functioning, VFrame can provision another device in the pool to take over the failing resource role. 
This can greatly reduce down time for your critical applications.

• Automated provisioning to handle increased application load—If an application requires additional 
resources due to a heavy load, VFrame can automatically provision additional resources to improve 
application performance. In general, application provisioning is policy based instead of based on 
dedicated resources.

• Improved resource usage—By pooling and provisioning resources based on service requirements, 
you can typically run your resources at higher usage levels. For example, with dedicated servers, 
during off-peak hours, an application might only use 10% of a server capacity. With service-oriented 
provisioning, you might be able to consistently run your servers at high capacity by reprovisioning 
servers from off-peak applications to peak applications. Potentially, this can reduce the number of 
servers required by your data center or delay the need to acquire additional servers.

• Equipment standardization—It is easier to set standards for your data center devices such as servers, 
storage, and network equipment.

• Standardized application deployments—You can create standardized application network templates 
that can be shared by many service networks within the same VFrame system, or export service 
network templates and import them into other VFrame systems (perhaps in other data centers). This 
lets you quickly deploy standard, tested setups throughout your organization, speeding up 
application deployments.
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VFrame Features
VFrame includes these features:

• Service Template Design—You can create templates for your service networks. Templates make it 
easier for users to create service networks because they do not have to start from scratch. You can 
leverage your application and networking expertise and share it among groups in your organization, 
because you can export and import these designs.

• Service Network Design—Service network design is the creation of a service network to run an 
application. These designs are based on templates. Instead of configuring specific hardware devices, 
you define the device requirements in service terms, so that VFrame can choose devices from 
resource pools when you deploy the service network.

• Service Network Operation—VFrame includes features for operating and managing a service 
network when you deploy the network and start using it to run an application.

• Service Network Policies—You can define policies for your operating service networks that 
automate features such as server failover and dynamic resource provisioning.

• End-to-End Infrastructure Visualization—You can view network maps of your physical resources 
and of the service design of your service networks.

• Device Discovery and Management—You discover the devices you want to manage and use the 
VFrame mapping feature to lay out and view your network. From the map, you can view the types 
of devices you have, and their contents, such as modules for switches, or logical units for your 
storage area networks (SAN). Device discovery and management includes features for defining the 
credentials used to log in to devices, and features for defining templates to use for discovering 
servers (LOM manager templates) and storage devices (storage manager templates) that are not 
supported by predefined templates.

• Resource Pooling—You can create resource pools to segment your resources in the manner that best 
fits your requirements. You can create dynamic pools that automatically include devices that meet 
specified criteria, or you can create pools with a hand-picked set of devices.

• Virtual Contexts—Virtual contexts give you another way of limiting user access to VFrame features. 
By creating a virtual context, you can create users who can log in to only that context. Then you can 
assign to the context just those resource pools and assets required by that set of users. Limiting the 
resources assigned to a context makes it easier for your users because they will not have to sort 
through resources that they cannot use.

• User Management—You can define users within VFrame. You can assign users roles that specify 
what types of actions they can perform in VFrame.

You can also use Cisco Secure Access Control Server 3.3 or later to control user authentication to 
VFrame virtual contexts. This allows you to integrate VFrame user control with your core user 
management functions. For more information on configuring the ACS server to work with virtual 
contexts, see Using an Access Control Server with Virtual Contexts, page 10-2.

• Roles—You can create roles that limit what users can do in the product, based on your rules for span 
of control. For example, you can create storage specialists who can do only storage-related actions 
when they log in to VFrame.

• Golden Image Management—You can create golden images of your servers that you can then deploy 
to other servers. This lets you create a single image for an application and reuse it whenever a server 
is provisioned to an application, ensuring that you have consistent server configuration.

• Macros and Variables—You can create custom macros and variables for use in your templates.
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• Fault Management—The fault management feature helps you monitor an operating network, 
identify problems, and respond to those problems. You can also configure VFrame to use your 
syslog server for logging system messages.

• Reporting—VFrame includes several reporting features to help you monitor and analyze the 
performance of your networks. You can have some of these reports e-mailed to specified users.

• High Availability (Redundancy)—You can configure two VFrame systems to work as a redundant 
pair. Redundancy ensures that if your primary VFrame Data Center Director fails, a backup takes 
over immediately.

• Application Programming Interface (API)—VFrame has an API you can use to integrate VFrame 
into your existing network monitoring systems.

• ESX—allows you to create virtual switches and port groups within your server groups. ESX 
partitions physical servers in multiple virtual machines. Each virtual machine represents a complete 
system, with processors, memory, networking, storage and BIOS. Multiple virtual machines can 
share physical resources and run side by side on the same server. Operating systems and applications 
can run unmodified in virtual machines. 

Note VFDC supports ESX 3.0 and later versions.

• VirtualCenter—VFrame Data Center supports VirtualCenter. The VirtualCenter provides you with 
a central point of control for managing, monitoring, provisioning, and migrating virtual machines.

Note VFDC supports VirtualCenter 2.0 and later versions.

• Virtual Machines—You can configure a virtual machine to run its own operating systems and 
applications as if it were a physical computer. A virtual machine behaves exactly like a physical 
computer and contains it own software-based, virtual CPU, RAM hard disk, and network interface 
card (NIC). An operating system cannot differentiate between a virtual machine and a physical 
machine, nor can applications or other computers on a network. Nevertheless, a virtual machine is 
composed entirely of software and contains no hardware components. As a result, virtual machines 
offer a number of distinct advantages over physical hardware. 

• Virtual Switches—You can connect other networking components together with a virtual switch, 
like you would with a physical switch. You can connect one or more virtual machines to a switch.

• Port Group—A port group specifies port configuration options such as bandwidth limitations and 
VLAN tagging policies for each member port. Network services connect to virtual switches through 
port groups. Port groups define how a connection is made through the vSwitch to the network. In 
typical use, one or more port groups is associated with a single virtual switch.

Understanding How to Use VFrame
VFrame is a highly flexible product, allowing you to divide work between many people in your 
organization. You can divide the work in any way that you see fit. You can take many different paths 
from the installation of the product to the deployment of real networks.

However, there is a generalized workflow to follow for going from a new system to deploying networks. 
Table 1-1 describes this generalized workflow. Keep in mind that many steps can be done concurrently 
or iteratively.
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Understanding How to Use VFrame
Some steps must take place in the Admin context. Some steps can take place in the Admin context or 
within a specific virtual context that you can create. If you are completing the entire end-to-end 
workflow, you might need to log in to the product in two contexts:

• AdminContext—Used for overall product management, device discovery and management, and 
virtual context creation and management. You can also perform service network design and 
operation.

• A user-defined virtual context—Used for service network design and operation.

Table 1-1 Overall Process for Using VFrame

Task

The following steps must take place within the Admin context.

Step 1 Create VFrame user accounts and roles.

VFrame includes a default user account named admin that has access to all 
product features. Typically, however, you will want multiple users to have 
access to the system, and you might want to restrict each user access to a specific 
area of expertise. For example, you might want a storage administrator to be able 
to only define storage device credentials and discover storage devices.

Create a user account for each user, and create roles to restrict access as 
appropriate for your policies.

For more information, see Managing Roles and Users, page 2-1.

Step 2 Verify the configuration of your data center network.

VFrame requires that devices in your data center network be configured in 
specific ways to work with the product. Your switches, service modules, servers, 
and storage devices must have certain features installed or enabled. You might 
also need to install storage managers and lights-out management (LOM) 
managers. For more information about the data center network setup 
requirements, see Setting Up the Physical Network, page 3-1.
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Step 3 Add devices to VFrame.

VFrame needs to know which devices you want it to manage, so you need to 
identify those devices and add them. The processes for adding devices to 
VFrame management differ, depending on the type of device, and you can have 
your device experts handle each type of device separately (such as network 
switches, servers, storage devices, and so forth). You need to complete these 
general steps:

1. Configure the credentials required to log in to the devices you want to 
manage with VFrame.

2. Configure a DHCP range to define the scope of VFrame server discovery.

3. Create LOM Managers for discovering servers or use VFrame-created LOM 
Managers for discovering natively-supported servers.

4. Create storage managers for discovering non-natively supported storage, if 
needed.

5. Have VFrame discover the devices and add them to the resources list.

6. Select which devices you want to manage with VFrame.

For more information, see:

• Managing Device Credentials, page 4-1

• Configuring DHCP for VFrame, page 5-1

• Discovering Devices, page 6-4

• Managing Devices, page 7-1

Step 4 Create golden images for managed servers.

Servers that VFrame manages must boot from the network and obtain their 
operating systems from VFrame. You need to create a golden image, that is, an 
image of the operating system and applications you want to run on the servers, 
for each type of server and application you are deploying. Install the VFrame 
Host Agent (VHA) on existing servers that you want to use as model servers for 
creating golden images.

Alternatively, you can import golden images that were created by another 
VFrame system and exported.

For more information, see Managing Golden Images, page 8-1.

Table 1-1 Overall Process for Using VFrame (continued)

Task
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Step 5 Create resource pools.

A resource pool is collection of a particular type of device or other resource 
(such as VLANs). By pooling resources, you can assign a group of them to an 
application instead of individual devices or other resources. VFrame requires 
pooling so that failed resources can be easily replaced by other resources in the 
pool, for example, replacing a server that stops functioning. How you define 
your pools depends on the needs of your organization, but a general best practice 
is to create separate pools for each service network you will define.

Besides creating pools for your discovered devices and other resources, you 
must also add ranges of IP addresses to the All IP Address Range pool. This pool 
includes all of the addresses that you are allowing VFrame to assign to devices 
acquired for use by service networks. Optionally, you can create other IP address 
range pools and copy address ranges to them, so that you can assign these pools 
to virtual contexts instead of the default pools (described in Step 7).

For more information, see Managing Resource Pools, page 9-1.

Step 6 Create templates to define the general design of service networks.

Templates provide a basic structure that you can use to design service networks. 
By creating templates, you make it easier for your user community to create 
valid service networks, and to control the types of networks they can create. 
When creating templates, you also create variables that service network 
designers will use to specify the requirements for their specific network.

Alternatively, you can import templates that were created on another VFrame 
system and exported.

Users can also create templates in virtual contexts.

For more information, see:

• Designing Templates, page 11-1

• Managing Global Libraries and Variables, page 12-1

Step 7 (Optional) Create virtual contexts.

A virtual context is a logically separate image of the VFrame system. A virtual 
context has its own resources, service networks, and user and role definitions, 
which cannot be seen by users of any other context except the Admin context. 
Thus, virtual contexts allow you to create separate systems for different groups 
in your organization without requiring you to purchase separate physical 
equipment for each. The single VFrame system appears to each group as their 
own system. Service network design and operation occur within virtual 
contexts.

For more information, see Managing Virtual Contexts, page 10-1.

The following steps can take place within a specific virtual context or within the Admin 
context.

Step 8 If necessary, create resource pools within a virtual context.

If you are running more than one service network from a virtual context, you 
might want to create resource pools specific to each service network.

For more information, see Managing Resource Pools, page 9-1.

Table 1-1 Overall Process for Using VFrame (continued)

Task
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Starting VFrame
Starting VFrame
You access VFrame using your web browser.

Before You Begin

You must install Sun Java 2 Runtime Environment (JRE) 1.5.x to run the product. The VFrame home 
page includes a link for downloading the JRE, or you can use this link to obtain the JRE from Sun 
Microsystems:

http://java.sun.com/j2se/1.5.0/download.jsp 

Also, you can run the client only on computers running the Windows 2000 or XP operating systems.

Procedure

Step 1 In your browser, open the VFrame home page. For example, if the DNS name of the VFrame Data Center 
Director management interface is vframe.example.com, the URL is http://vframe.example.com.

You can use the IP address of the management interface instead of the DNS name. If you are using a 
high-availability configuration, use the virtual IP address or its DNS name.

Note To open a secure connection, use https://server_name:443.

Step 2 On the VFrame home page, click the link to open the client.

This downloads the client to your machine and starts it. If this is the first time you are starting the client, 
it might take a while to download, depending on the speed of your network connection. An updated client 
is also downloaded if the system was upgraded since the last time you started the client.

Step 9 Design a service network.

In service network design, users use the provided templates to create the 
definition of a real network. Instead of specifying a specific server, for example, 
they define the type of server needed based on server features, such as processor 
speed. Because networks are based on service characteristics, when you deploy 
them, VFrame has the flexibility to choose appropriate, and available, hardware 
from the assigned resource pools.

For more information, see Designing Service Networks, page 13-1.

Step 10 Deploy, operate, and monitor the service network.

After the service network is designed, you can deploy it so that your 
organization can use the applications running on the network. VFrame includes 
many features for managing and monitoring the network.

For more information, see:

• Managing Operations—Basic Workflow, page 14-1

• Managing Fault Alarms, page 15-1

• Viewing Reports, page 16-1

Table 1-1 Overall Process for Using VFrame (continued)

Task
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Click Yes on any security warnings. The VFrame Logon dialog box appears.

Step 3 In the Logon dialog box, enter your VFrame username, password, and select the name of the context to 
which you are logging in.

To log in to the administrative context, choose the AdminContext. Other context names are user-defined 
and thus unique to your organization. You can only log in to contexts for which your user account is 
authorized.

The only preconfigured user is admin, and the admin password is configured during initial system setup.

Click Login to log in to the system.

Tips

• If you cannot start the client, or it starts but does not function correctly, delete the cached version of 
the client and start over. To delete the cached client, select Start > Run and run javaws (the Java 
Web Start program). Select the VFrame client and click Remove Selected Application.

• If clearing the cache does not help, try connecting to VFrame using a different browser. For example, 
if you have trouble connecting through Internet Explorer, try Firefox. Also, analyze your browser 
security settings to ensure they do not prevent you from running Java programs.

• If you upgrade VFrame, you should clear the old client from the Java cache.

Related Topics

• Working with the VFrame Interface, page 1-9

• Exiting VFrame, page 1-16

Working with the VFrame Interface
This section explains how to use the VFrame interface, and includes the following topics:

• Overview of the VFrame Interface, page 1-10

• Customizing the VFrame Interface, page 1-11

• Your Privileges Affect What You See!, page 1-11

• What Happens When More Than One User Logs In, page 1-11

• Changing Your Password, page 1-12

• Using Shortcut Menus, page 1-12
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Overview of the VFrame Interface
Figure 1-1 describes the major parts of the product interface.

Figure 1-1 VFrame Main Window

1 Title bar. The name of the VFrame Data Center Director is displayed here.

2 Menu. Use the commands in these menus to access product features. You see only the commands 
to which you have authorization. As a result, you might read sections in the help that mention 
commands that you cannot see.

3 Login status. This area shows the user account and virtual context name for this session.

4 Tab control. These buttons control the displayed feature tabs. Use the < and > buttons to scroll 
through the tabs when you open so many that they extend beyond the window frame. To go back 
to a tab that is already open, click the tab name. Click the menu icon to get a list of open tabs, from 
which you can choose the tab you want to make active.

5 Status bar. Look for status here. The product displays a loading status bar when you select a feature 
and displays other messages when you perform various tasks. The status bar also displays the 
current time on the VFrame Data Center Director.

6 Progress bar. When you initiate a task, such as opening a service network, this bar appears and 
shows the progress made for the task. If you have multiple pending tasks, you can click the 
progress bar or the up arrow button to open the Progress Monitor pop-up that shows progress bars 
for all of your pending tasks. To close the Progress Monitor pop up, click the down arrow button. 

7 Feature tabs. This area is where you use most product features. In general, tabs are divided into 
two sections. The left side contains a list of the elements defined for the feature (for example, 
discovered devices on the Resources tab, or resource pools on the Pools tab), and the right side 
displays the contents of the item selected in the left tab. Click the X in the tab title to close the tab. 

8 Toolbar. Some of the commands in the menus have toolbar buttons that you can use as shortcuts. 
Pass your mouse over the buttons to see the name of the feature.

1 2 3

4
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8

24
21

22
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Customizing the VFrame Interface
You can set a user preference to control which tab is opened initially when you log in. To set the home 
page, choose Tools > User Preferences, and select the desired home page. Click Use Current to use the 
tab that is currently displayed in the interface. 

Your Privileges Affect What You See!
When you log in to the product, what you are able to see and do depends on the privileges assigned to 
your user account. These privileges are defined by your assigned role.

If you cannot see a feature or modify a setting, it is usually because of your role assignment. If you 
believe you should be able to perform certain tasks in the product, contact your local administrator about 
changing your privileges.

Besides affecting what features you can see or tasks you can perform, your privileges also affect the 
types of events you might see.

For more information about user accounts and roles and their privileges, see Understanding Roles and 
Local Users, page 2-1.

What Happens When More Than One User Logs In
VFrame supports multiple simultaneous users. Thus, when you log in, another user might also be logged 
in. During service network operations, some items might be locked and prevent you from running 
discovery jobs. You can create the discovery job, but the lock delays the start of the job.

Other than service network operations, VFrame does not place locks on items that you are modifying, 
so there can be conflicts between your actions and the actions of the other users.

If the other users work in other areas of the product, for example, they control resources or system 
aspects to which you do not have access, then there is little likelihood that your changes will conflict 
with the changes of other users.

However, if another user can make changes to the same items that you can change, you might see these 
things happen:

• If another user saves changes to an item you are working on, you might not be able to save your 
changes. This can happen if the changes from the other user invalidates your changes.

• If another user saves changes that do not invalidate your changes, when you save your changes, any 
differences with the other user are overwritten by your changes.

• If another user saves changes after you save your changes, the changes from the other user can 
overwrite your changes.

You can check on whether other users are logged in by choosing Tools > VFrame Administration > 
Users to open the User dialog box, and then clicking the Logged in Users tab.
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Changing Your Password
After you log in to the product, you can change your password. If you forget your password, contact the 
system administrator to have it changed.

Before You Begin

You cannot change the admin user password using this procedure. To change the admin password, you 
must use the command line. For more information, see the user password command in the Cisco 
VFrame Data Center Command Reference.

Procedure

Step 1 Choose Tools > User Preferences to open the User Preferences dialog box.

Step 2 Click Reset Password. The Reset Password dialog box opens for you to enter your new password.

Step 3 Enter your current password, then your new password. Reenter your new password to confirm it. When 
finished, click OK. Your password is changed.

Using Shortcut Menus
On many of the tabs in the VFrame interface, if you select an item and click the right mouse button 
(right-click), you are presented with a shortcut menu that includes many of the options available as 
buttons or menu items for that type of resource. Using options from shortcut menus has the same results 
as using the menu option or buttons. In many cases, the procedures in the online help mention only one 
method of completing a task, but you can use whichever technique you prefer.

Viewing Job Logs
Most actions that you take in the product are considered jobs. You can schedule some of the actions, such 
as those involved in device discovery. In many places in the interface you will find a job status viewer 
where you can see the status of these jobs. The job status viewer is similar in all of these areas, so that 
once you understand how to view job status in one area, you will understand how to view it in others.

When you are logged in to the Admin context, you can see a consolidated view of jobs by choosing 
Tools > Job Logs. You can set a filter to view select types of jobs rather than all jobs. The jobs listed 
include those that you initiate and those that VFrame runs to manage the system.

Table 1-2 describes the general use of the job status viewer, and applies to any place where you find a 
listing of jobs.
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Table 1-2 Job Logs Dialog Box

Element Description

Job List (Upper Pane)

Filter button

If a filter is applied to 
the list, the button name 
is shown as:

Filter... (filtered)

Click this button to create a filter so that the list shows only the jobs that you 
want to see. The Filter dialog box is opened, and you can use these fields to 
set a filter:

• Job Type—The type of job you want to see, related to the action 
performed by the job, arranged hierarchically in folders. Select a folder 
to select all job types in the folder. If you want to select only one or two 
job types, first deselect All, then make your selections.

• Status—The job status. For example, you can elect to view jobs that are 
currently running.

• Time Range—Whether to view all jobs no matter when they ran (All), 
or to view jobs that ran on specific dates within specific times.

• Max Results—The maximum number of results you want to see. For 
past jobs, the most recent ones are selected over older jobs.

• Apply button—Click this button to apply your filter to the list without 
closing the Filter dialog box. Click OK to apply the filter and close the 
dialog box.

• Reset—Click this button to reset all filter values to their defaults (which 
is to view all jobs without date and time restrictions).

Show All button Click this button to display all jobs, removing any filter that is currently set. 
To reapply the filter, click Filter to open the Filter dialog box (which retains 
the previous filter values) and click OK.

Context The name of the context where the job runs.

Name The name of the job.

Type The type of job.

Status The status of the job. The status Scheduled indicates the job is scheduled to 
run in the future. Scheduled and Unscheduled jobs do not have log entries.

Start Time The date and time the job started. For scheduled jobs, when it is scheduled 
to run next.

Percent Complete How much of the job has finished.

Duration The amount of time the job took to finish.
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Job Logs Tab (Lower Pane)

The job log shows the messages for the job you select from the upper panel. To change the sorting order 
of the messages, click the column title on which you want to sort.

Some jobs, especially system-initiated jobs such as database pruning, do not include detailed 
messages, so the job log might not display detailed messages for a selected job.

The columns displayed depend on the type of job you select in the upper pane:

• Standard Job Log Columns, page 1-14—For most jobs, these columns are shown.

• Service Network Job Log Columns, page 1-14—For jobs where the job type is for service 
networks, these columns are shown. Service network jobs include the words Fault, Service 
Network, or Logical Network in the job type.

Standard Job Log Columns

Job Log Filters Use the filter to reduce the size of the list and show only those messages you 
want to see. Filter elements include:

• Severity—The severity level of the message.

Severity The severity level of the message.

Time The date and time the message was logged.

Entry The job log message.

Service Network Job Log Columns

Max Results The maximum number of messages that you want to see. The most recent 
messages are shown.

Filter button Click this button to open the Filter Settings dialog box where you can define 
a filter to limit the types of messages displayed in the job log.

In the Filter Settings dialog box, on the Filter tab, select the attributes that 
define the messages that you want to see. Click the More link to add other 
types of attributes. You can filter on most of the fields shown in the job log 
(described below).

Details button Click this button to open the Log Record Details dialog box for the selected 
row, which is the same as double-clicking the row or selecting Show Details 
from the right-click shortcut menu.

The Log Record Details dialog box displays the message information in a 
more readable format. You can use the < and > buttons to scroll through the 
task result summaries.

Severity The severity level of the message.

Time The date and time the message was logged.

Job Name The name of the job.

Entry The job log message.

Event Name The type of event that occurred. For a complete list of event types, see 
Events, page 11-7.

Activity The user-defined macro or system action.

Target Element The name of the service network element affected by the activity.

Table 1-2 Job Logs Dialog Box (continued)

Element Description
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Target Element Type The type of service network element.

Target Resource The physical resource affected by the activity, if any.

Target Resource Type The type of physical resource.

Task Results Tab (Lower Pane)

The Task Results tab shows the messages for the macro events for the job you select from the upper 
panel, if any macros were executed during the job. To change the sorting order of the messages, click 
the column title on which you want to sort.

Each task has an associated job log you can view to see detailed execution information.

Details button Click this button to open the Log Record Details dialog box for the selected 
row, which is the same as double-clicking the row or selecting Show Details 
from the right-click shortcut menu.

The Log Record Details dialog box displays the message information in a 
more readable format. You can use the < and > buttons to scroll through the 
task result summaries.

Logs button Click this button to open the macro execution log for the selected row, if 
there is a log associated with the action. The log includes the commands sent 
to the device and the device prompts and responses. Logs are only available 
for user-defined macros.

Perl Routine button Click this button to open the Perl file that was generated before running the 
macro for the selected row. This button is active only for user-defined 
macros.

Variable File button Click this button to view the variable values that were generated before 
running the macro for the selected row. This button is active only for 
user-defined macros.

Status The status of the action, indicating whether it was successful.

Last Update Time Time the action was completed.

Event Type The type of event that occurred. Use the information in the Event Name field 
instead of this field.

Event Name The type of event that occurred. For a complete list of event types, see 
Events, page 11-7.

Action The name of the action.

Action Type Whether the action was system- or user-initiated. User-defined events or 
macros have the User action type.

Message The error or informational message issued after the action occurred.

Resource The physical resource associated with the target element.

Source SNE Name The name of the service network element that performed the action. For 
LOM manager actions, this is the name of the LOM manager. In most cases, 
the source and target service network element are the same, which indicates 
that VFrame performed the action.

Target SNE Name The name of the target service network element on which the action 
occurred.

Table 1-2 Job Logs Dialog Box (continued)

Element Description
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Exiting VFrame
When you are finished using the product, choose File > Exit to close the product.

Closing the product does not affect any running service networks or scheduled jobs; it only ends your 
session.

Prev. Reset Status The status of the error before it was cleared. If there is no previous status, 
NA is displayed.

Reset By The username of the person who cleared the error. If there is no previous 
error reset, NA is displayed.

Table 1-2 Job Logs Dialog Box (continued)

Element Description
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